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Creating accessible PDF documents with 
Adobe® InDesign® CS6

It’s critical that content is accessible to the widest possible audience and complies with accessibility standards 
and regulations, such as WCAG 2.0 and Section 508 of the U.S. Government’s Rehabilitation Act. An 
“accessible” electronic document is one that is optimized for screen readers and other assistive devices used by 
persons with disabilities. Producing accessible content also plays a key role in optimizing PDF documents for 
successful indexing by Internet search engines.

Achieving this kind of accessibility requires tagging all document content based on its hierarchical structure 
(headings, paragraphs, lists, tables, and so on) and ordering the content in a linear path from start to finish. An 
additional requirement for accessible documents is identifying nontext content, such as graphics and images, 
in context and describing what is shown.

InDesign CS6 offers a direct and simple workflow that dramatically reduces the time and effort required to 
produce accessible PDF documents from an InDesign layout. Most of the tasks are executed within InDesign, 
with only a few final steps required in Adobe Acrobat®. This allows hierarchical and structural information to 
reside in the InDesign file, making updates faster and easier when you need to generate a revised accessible 
PDF document.

To accomplish the tasks described in this white paper, you will need:

•	 Adobe InDesign CS6 software to prepare a document for accessible PDF export using the processes 
described.

•	 Adobe Acrobat X Professional to finalize the accessibility process. You cannot accomplish these steps with 
the free Adobe Reader® application.

Optionally, you might also need access to assistive technology (AT) for testing and verifying results beyond the 
Acrobat built-in accessibility accommodations.

Workflow for generating an accessible PDF document from InDesign CS6

You can perform the majority of the work necessary to properly structure and prepare a document for 
accessibility can be done directly in InDesign CS6, reducing the post-export work required in Acrobat X Pro to 
jsut a few steps. You can specify the document’s structural hierarchy and content order in the InDesign 
document, which preserves that structure should you need to later modify the document and export a new 
PDF.
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Required steps in InDesign CS6
Use paragraph styles consistently throughout your document. Consistent use of InDesign paragraph styles 
throughout a document is critical for efficiently and successfully exporting the content to PDF. Base styles on 
their hierarchical structure (main headline, secondary headings, subheading, and so on) and apply them 
appropriately to paragraphs according to their hierarchical role in the document.

Establish export tag relationships between InDesign styles and PDF tags. As you create InDesign styles, set 
each style’s Export Tagging (in the Paragraph Style Options dialog) according to its role in the PDF document—
paragraph (P), heading levels 1 through 6 (H1–H6), or Artifact. Tables and bulleted and numbered lists are 
recognized automatically in the export process and tagged appropriately.

Anchor images within the content flow. Images in a print layout can appear anywhere in a spread, and sighted 
users can make the connection between the image and relevant text as they read. Screen readers process 
content in a linear fashion. Because screen readers use text-to-speech facilities to describe images, they should 
be placed as close as possible to the text that pertains to the image. InDesign’s drag-and-drop object anchoring 
makes it simple to place the reference to the image in an appropriate location without affecting the print 
layout..

Add alternative text for images. Screen readers can only indicate the presence of an image. Conveying what 
the image depicts requires providing alternative text (alt text). With the Object Export Options feature in 
InDesign, you can specify alt text from metadata in an image file or add custom alt text to any image, graphic or 
group of objects in a layout.

Incorporate internal document navigation mechanisms. In an accessible PDF, tables of contents, bookmarks, 
hyperlinks, and cross-references can act as navigation mechanisms to the referenced content. They also allow 
screen reader users to efficiently navigate the document by using the links these mechanisms create.

Establish content order in the Articles panel. The tagging order of a PDF document is essential to its 
readability. The Articles panel in InDesign CS6 enables you to precisely define which content in your document 
gets tagged and in what order. You can add content by dragging and dropping frames and objects into the 
Articles panel and then arranging them in the desired reading order. You can also break the content up into 
smaller articles without affecting the page layout.

Specify a document title and description as metadata. For accessibility, as well as for search engine 
optimization, a PDF file requires a document title and a description of its contents. When you save this 
information in the InDesign File Information dialog, it’s automatically transferred to Acrobat Pro X as required 
metadata. 

Export as PDF with settings optimized for accessibility. When you use the InDesign PDF export options (print 
or interactive), the tagging, organizing, and bookmarking established in the layout become the tagging 
structure, order, and navigation scheme of the resulting PDF document.

Required steps in Acrobat X Pro
Set the language in Document Properties. You cannot set the document’s language in InDesign. You must 
specify the language in the Advanced options area of the Acrobat Document Properties dialog.

Change display name from Filename to Document Title. By default, Acrobat displays the PDF filename in the 
title bar of the document window. For accessibility purposes, this should be replaced by the document title 
established in InDesign’s File Information dialog. To do so, choose Document Title instead of Filename in the 
Initial View options of Acrobat’s Document Properties dialog.

Set the tab order to use the document structure in the Page Thumbnails pane. The structure established in 
the InDesign Articles panel is saved in the exported PDF file, but you must instruct Acrobat to honor that 
structure. To use the order specified by the InDesign document’s structure, select all the pages in the Acrobat’s 
Page Thumbnails pane, choose Page Properties from the Options menu, then select Use Document Structure 
for the tab order.

Run the Acrobat accessibility check. After these steps are completed, confirm that the document has no errors 
by choosing Full Check from the Acrobat accessibility tools.
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Creating an accessible PDF

Add Export Tagging instructions to paragraph styles
Defining export tags in a paragraph style creates an association between the text using that style and its role in 
the semantic structure of the PDF document. You can set any paragraph style to one of eight basic PDF tags.

PDF tag Applied to

<P> Any standard, narrative paragraph of text that is not a heading

<H1> through <H6> A heading that reflects the document’s organizational hierarchy

<Artifact> Any page content that the screen reader should ignore

If you do not assign export tags, all styles default to Automatic. The Automatic setting honors any style-to-XML 
tagging that might have been established in an older XML-based workflow. If no style-to-XML relationships 
have been established, the Automatic setting translates them to a P tag in Acrobat. There is no additional 
parsing of the document to determine a heading structure. Because of this default behavior, explicitly assigning 
export tags to paragraph styles is an essential accessibility step.

You set the Export Tagging options for a style in the Export Tagging area of the Paragraph Style Options dialog. 
If you use InDesign’s Bullets and Numbering feature, bulleted and numbered lists are tagged as unordered or 
ordered lists, respectively, and converted automatically, depending on the options selected in the export 
process. Manually created lists are not recognized as list items.

InDesign’s Export Tagging settings allow two different tagging schemes. The options for EPUB and HTML have no bearing on the options for PDF, 
which must be set independently. Although the role assigned to a specific paragraph will likely be similar between the two, PDF has fewer options 
and no custom tagging options.

Understanding roles in 
a tagged PDF
Assigning a paragraph 
style to a particular 
export tag defines its 
role in the tagged PDF 
file. For instance, text 
using an InDesign style 
named “Main Headline” 
might appear in the 
Acrobat Tags panel 
with a <Main Headline> 
tag wrapped around 
it, but in the Edit Role 
Map dialog in Acrobat, 
that Main Headline tag 
is assigned the role of 
<H1>, if H1 was defined 
as the style’s export tag 
in InDesign.
Similarly, if a text flow 
in InDesign is tagged as 
<Story>, it is automati-
cally mapped to the 
section (<Sect>) role in 
Acrobat.
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If a project already has styles, you can map all styles in the document in one step by choosing Edit All Export Tags in the Paragraph Styles panel menu 
(left). In the resulting dialog (right), select the PDF option and assign PDF tags from the pull-down menus in the right column to the paragraph style 
names in the left column. 

In Acrobat, the Role Map reflects the associations made between the InDesign Header style and the H1 tag and between the Section headers style 
and the H2 tag, both of which were assigned in the Export Tagging options for the respective styles in InDesign.

Add Alt text using Object Export Options
Images in an accessible PDF document require alternative text so that the image can be described by a screen 
reader or assistive device. In previous versions of InDesign, you could only add alt text for an image through 
the XML Structure pane. That option is still available, but in InDesign CS5.5 and CS6, you can also add alt text 
with Object Export Options (Object > Object Export Options). This dialog is non-modal, so it can remain open 
as you work in the document, allowing you to move quickly from image to image and assign metadata without 
repeatedly closing and opening the dialog.

The Object Export Options dialog has three tabs—Alt Text, Tagged PDF, and EPUB and HTML. Alt Text applies 
to both the PDF and EPUB/HTML workflows. You can generate the alt text from the document’s XML structure 
(if any exists) or the image’s XMP metadata (if present). Or you can directly add the alt text to the specific 
instance of the image in the layout by selecting Custom from the Alt Text Source pull-down menu.
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 The XMP metadata for an image (top, shown in Adobe Bridge) is available as potential alt text in InDesign.

In the InDesign Object Export Options dialog box, you can assign alt text  (left) from either data in a document’s XML structure or information stored 
in its XMP metadata. You can also enter custom alt text. This dialog box is also where you designate which object tag Acrobat applies (right) in the 
PDF document. Typically, the Based On Object option is the appropriate choice, but you can also choose a tag from the document’s XML structure (if 
any) or tag the object as an artifact to be ignored by screen readers.

Specifying alt text from XMP metadata is the best choice in most cases, because the link between the alt text 
and the metadata in the file is dynamic. If the metadata changes, alt text is updated when you update the 
image link in your InDesign document. Not including alt tags for all of your images will result in errors later in 
the workflow when you run the Acrobat accessibility check.
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In the final PDF document, alt text appears as a tooltip when the user hovers over an image. The alt text is also read as a description of the image 
when Acrobat’s Read Out Loud feature is used, or when the PDF is read by an assistive device or screen reading software.

Anchor images into the text flow
When images are placed on a page in a print layout, they do not necessarily need to be placed adjacent to the 
copy that refers to them. For sighted users, it’s not unusual for text to contain references to an image located 
elsewhere in the document. However, when you’re establishing a flow of content for an accessible PDF 
document, those images should be described t the appropriate point within the flow. InDesign allows you to 
place a machine-readable reference to the image in the text by anchoring the graphic frame containing the 
image to an appropriate location within the text frame. This process has been a multistep task in earlier 
versions of InDesign, but was dramatically simplified in InDesign CS5.5.

Each InDesign frame and object group displays a small blue square on its top edge. To anchor an object in an 
accessible location in the text flow without changing the original position of the object, click and hold the blue 
square, and then drag it to the desired location within the text and release. The blue square changes to an 
anchor icon indicating that the object is anchored.
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To anchor an object, drag the blue square on a frame (left) to the desired location in the text. When anchored (right), the blue square becomes an 
anchor icon.

In the PDF file, the Figure tag for the anchored image appears within the appropriate <body_copy> tag in the main article and will be referenced and 
described by its alt text at that point.

Establish a reading order with the Articles panel
InDesign’s Articles panel allows you to establish a document’s content reading order for Acrobat entirely within 
InDesign without using the XML structure pane. Acrobat understands this order and will follow it in the 
exported PDF once you instruct it to do so in Acrobat X Pro.

To establish the reading order in InDesign, open the Articles panel (Window > Articles) and click the desired 
object or objects on the page to include in the article. Drag the objects into the Articles panel, and release the 
mouse. Objects are listed in the order that you click them. Name the article when prompted to, or keep the 
default name Article 1. Alternatively, you could use Select All (Cmd/Ctrl-A) and click the New Article button at 
the bottom of the Articles panel to add all selected objects and create a new article in one step (you can 
rename it later). Objects are given default names based on the object’s type and content. If an object has 
already been given a specific name in the Layers panel, it retains that name in the Articles panel.

Tagging anchored text 
frames
You can anchor text 
frames within other 
text frames. In previous 
versions of InDesign, 
anchored text frames 
were incorrectly tagged 
as <Figure>, but in 
InDesign CS6, they are 
now tagged as <Story>. 
However, the content 
within the anchored 
text frame receives no 
additional paragraph, 
table, or list tagging 
when exported. All 
content in the frame 
is enclosed only in the 
<Story> tag.
When possible, use 
the Articles panel to 
organize additional text 
frames such as sidebars 
to preserve desired 
content tags.

Tip
When you add multiple 
opjects to the Articles 
panel at the same time, 
the objects are listed 
in the Articles panel 
in the order in which 
they were clicked on 
the page. If you select 
page elements to add 
using Edit > Select All 
or by using the options 
available in the Articles 
panel menu InDesign 
determines the order, 
which might not 
correspond with your 
desired order.
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When adding a new article to the InDesign Articles panel, you must select Include When Exporting (the default) for the article to be properly tagged 
and ordered in the PDF file.
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Werner Haupfmann, the multi-use building 
incorporates ground-floor arcades similar to those 
Haupfmann admired on the Places des Vosges in Paris. 
Atmospherically tucked into two of the adjoining 
barrel-shaped spaces next to the museum is Gabel 
and Löffel, one of the city’s oldest and most beloved 
restaurants.

Automobile traffic is mostly banned from the 
cobblestone streets of Old Town1, making the district 
a pedestrian paradise. Window shopping is a regular 
pastime among visitors and residents alike. So is 
ambulatory grazing. For a full meal afoot that would 
make even the most adventurous foodie giddy, 
the newly established Tryon Row Market is a food 
cart diner’s dream. Hipster kids, food bloggers and 
restaurant critics chat excitedly with the rest of the 
food curious lined up at an ever-changing array of 
catering trucks that work culinary magic in phone 
booth sized kitchens.2

Just across the park, the market stalls at Hazel 
Street maintained by the Heritage Growers Association 

1Motorcycles and other two wheel motorized vehicles are allowed.
2This is another exception to the no auto traffic rule.

boast produce, meats, cheeses and prepared foods 
from local farmers and purveyors year round. Heritage 
Growers is a grass-roots effort started by Old Town 
residents weary of the big-box supermarket model. In 
collaboration with area produce growers the group was 
able to establish a bi-weekly organic farmer’s market 
that quickly became a daily source of sustainably 
produced seasonal foods. Today, the market supplies 
dozens of area restaurants while continuing to cater to 
urban locavores.

The market is a favorite of picnickers attending 
Meridien’s annual Outdoor Film Festival, the marquee 
event that draws crowds to Old Town every August. 
Film buffs screen feature-length and short films at 
a range of open-air venues, from sidewalk cafes to 
brownstone parking lots to the 500-seat Sterling 
Amphitheater in Sandhill Park. As festival-goers and 
locals wander the lamp lit cobblestones on warm 
summer nights, it’s hard to imagine a city setting 
more inviting. Old-world charm meets a decidedly 
contemporary attitude toward diverse community 
building and sustainable urban planning in Old Town. 
The result is a whole lot of fun.
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Restaurants Acqua E Farina
Italian | Old Town
5551 Sand Hill Road
Meridien, MV

“Italian cuisine” is somewhat of a misnomer, since cooking in Italy remains 
stubbornly regional. The menu at Acqua e Farina makes delicious hay from this 
intractable regionalism. Or rather, it makes exquisite pasta. (“Water and flour,” says 
chef-owner Cesare Pavese, “it’s the essential starting point in the Italian kitchen.”)

Milanese tortellini in come bathed in a rich, golden brodo. Pillowy gnocchi get 
an edge from the sharpness of basil and Asiago cheese in Genovese sauce. Sweet and 
savory combine in unexpected ways in Tortelli Cremonese, unusually large ravioli 
stuffed with ricotta cheese and crushed biscotti served with sage butter and shaved 
Grana Padano.

Pasta is irresistible at Acqua e Farina, but it’s not the only thing on the menu. 
Hearty dishes like grilled rabbit with creamy polenta and wood fire-roasted suckling 
pig are winter staples. During truffle season, the delicately scrambled white truffle 
eggs are simply not to be missed. It’s hard to think of dishes this refined as comfort 
food, but comfortable is certainly how Pavese and his staff make diners feel.

Gabel and Löffel
German | Old Town
4100 Chestnut Street
Meridien, MV

Vaulted ceilings, massive chandeliers made from stag antlers, towers of ancient 
beer casks, rough-hewn plank tables: dining at Gabel and Löffel feels, at first blush, 
like an invitation to a Bavarian hunting lodge. Atmospherically tucked into two of 
the adjoining barrel-shaped spaces next to the museum is Gabel and Löffel, one of 
the city’s oldest and most beloved restaurants. What never ceases to surprise first-
time visitors to this Old Town institution is how light and appealing everything on 
Ute Braun and Gabby Löffel’s menu is when it comes to the table.

Löffel, the executive chef, is also the great-granddaughter of Helmut Löffel, the 
restaurant’s founder. She brings a distinctively West-coast attitude to the classic 
cuisine of middle Europe, giving old favorites a nouvelle spin. Braun, a longtime 
fixture on the Meridien restaurant scene, has brought her relationships with some 
of the state’s finest ranchers and farmers to bear in bountiful ways. Nowhere else 
will you find delicacies like Twin Hills Farm knockwurst, Bigeye Polish sausage or 
Hermosa Ranch white asparagus produced exclusively for the Gabel and Löffel menu. 

An obligatory culinary experience for eaters of every ilk!
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Bars &  
Hangouts

Font of Knowledge Pub
Speakeasy | Old Town
2130 Walnut Street
Meridien, MV

Housed in a former M.U. library, this many-roomed gathering spot is as 
welcoming as a broken-in easy chair. College students tend to congregate around the 
air hockey and ping-pong tables in the “stacks” on the lower level, while business 
folk gather after work along the handsome, dark walnut bar in the foyer and at 
communal tables in the adjoining reading rooms. 

Font of Knowledge boasts one of the city’s most extensive lists of local and 
international microbrews. It also features a small but intelligently edited selection of 
organic and biodynamic wines. The weekly specials board highlights both seasonal 
brews and small-production wines scouted out by the pub’s uncannily tuned-in owners, 
brothers Bryce and DuBois Washington. 

Original “bar bites” are available all day and run the gamut from panko and herb-
crusted goat cheese fritters to grass-fed buffalo and bleu cheese sliders. The sweet 
potato frites with chipotle aioli are equally dynamite with a local Snowshoe pale ale 
or a New Zealand stout. Nothing here to keep quiet about.

Tryon Row Market
Various Cuisines | Old Town
100 Hazel Street Meridien, MV

Meridien dwellers are turning out in droves, rain or shine, for the latest 
gastronomic gambit to hit town: the food truck. Business is so brisk at these mobile 
watering holes the city has given the vendors a place to call home. Now, instead of 
tracking the trucks from location to location via tweets and text messages, devoted 
followers can find their favorites at Tryon Row Market several days a week.

From Mumbai street food to Mexican sushi, artisan hot dogs smothered in house-
made sauerkraut to everybody’s favorite “breakfast on a stick,” the food may be 
served up fast but the ethos is decidedly slow. Several of Meridien’s up-and-coming 
young chefs have set up their own mobile kitchens in lieu of more expensive brick-
and-mortar locations. The upside: more truly superb choices in a city fanatical about 
its food.

To give vendors equal play, the trucks swap out from one day to  
the next. You never know what combo of cuisines will be vying for your taste buds 
when you hit Tryon Row. But you can be certain you won’t walk away hungry.
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FOUNDED 1840
POPULATION DENSITY 4,439/km2 (11,496/mi2)
TOTAL AREA 365.13 km2 (140.98 mi2)
LAND AREA 47.95 km2 (18.51 mi2)
WATER AREA 53 km2 (20.5 mi2)

Meridien is a city brimming with energy for 
reinvention. One of its most recent success 
stories is the renaissance of the Old Town 

district. Just five years ago, the quaint cobblestone 
streets unique to the neighborhood were strewn with 
trash. The city’s homeless would congregate here, and 
historic buildings were primarily abandoned. With the 
election of Mayor Pierre H. in 2006, the city allocated 
funds for a renewal project that provided businesses 
and nonprofits with startup funding to renovate and 
occupy the empty structures. Before long, artists were 
occupying the upper floors, and boutiques, galleries 
and cafés began to spring up to support their lifestyles. 
Robust social service programs provided housing and 
drug counseling, and the area underwent a remarkable 
metamorphosis.

The heart of Old Town is Coast Avenue, bounded by 
Sandhill Park to the West and Shoreline Highway to the 
East. It’s hard to imagine the elegant landmark 
low-rises facing the park as the  boarding houses and 
residence hotels they once were. Today art galleries, 

boutique creative agencies and gourmet coffee shops 
occupy the first-floor commercial spaces behind 
pristinely restored Georgian facades. On the floors 
above, towering windows fill artist’s studios and large, 
gracious apartments with light. The park is a social hub 
for those who work and live nearby. Black-clad design 
types and dreadlocked artists share the sunny 
lunchtime lawns with young moms, toddlers and dogs. 
Lots and lots of dogs. People in Meridien are canine 
crazy, which explains the pint-sizes drinking fountains 
at both entrances to the park.

Lining Coast Avenue from the park down the 
handful of blocks to Shoreline Highway are more 
lovingly preserved buildings housing boutique start-
ups, one-off clothing shops, wine bars, restaurants, 
several community-focused non-profits and a not-
to-be-missed museum of Bavarian folk instruments. 
The quirky museum occupies a small storefront in 
the striking Haupfmann building, which fills the 
entire block between Tryon and Chestnut streets. 
Completed in 1847 by German émigré architect 

To make sure that the order in the Articles panel is communicated to Acrobat when you export, select Use for Reading Order in Tagged PDF option 
from the Articles panel menu.

Organize your content in the Articles panel by dragging an item within an article up or down until all items are 
in the desired order. The reading order is from top to bottom. Reordering in the Articles panel does not affect 
the position or appearance of items on the InDesign page. You can also add elements from different parts of 
your layout into an existing article by dragging them from the layout into the Articles panel, or selecting them 
and choosing Add Selection to Selected Articles from the Articles panel menu. To break up your content’s 
structure appropriately, you can create multiple articles.

Add bookmarks, cross-references, and hyperlinks for navigation
Cross-references (for example, “See Dining, page 24”), hyperlinks, and bookmarks are conveniences to sighted 
readers, but are also essential navigation tools for the visually impaired. These navigation mechanisms are the 
means by which users with disabilities move through a document and get an overview of its content and how 
that content is organized. A table of contents (TOC) generated in InDesign can add bookmarks automatically 
when the Create PDF Bookmarks option is selected in the Table of Contents dialog. You can also add custom 
bookmarks independent of a dynamic TOC in the Bookmarks panel (Window > Interactive > Bookmarks). You 
can link bookmarks to either text anchors (bookmarks created when specific destination text is selected) or 
pages (bookmarks created when viewing a page in InDesign with no text selected).

Recommendations for 
organizing content
Each story in an article 
is enclosed in a <Sect> 
tag within the parent 
<Article> tag, identify-
ing it as a section of 
the overall article 
and maintaining the 
contextual connection 
between the different 
pieces of content.
To ensure that content 
related to a specific 
article, such as a 
sidebar, maintains 
its connection to 
that article, add the 
content to the article 
in the Articles panel 
rather than adding it as 
a new article.
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You can arrange bookmarks hierarchically in the InDesign Bookmarks panel (left) as well as nest specific bookmarks under broader categorical 
bookmarks for a clearer indication of a document’s distinct sections. When exported to PDF with the proper settings, the InDesign bookmarks and 
their organizational structure are matched exactly in the Acrobat Bookmarks pane (right) and work as clickable links to the appropriate content.

Hyperlinks—either to external locations like websites or to in-document locations like text anchors—provide 
additional navigation points on a more micro level that might not be appropriate or necessary in the 
document’s bookmark structure. PDF hyperlinks are created upon export for links created in the InDesign 
Hyperlinks panel, and any cross-references established using the InDesign Cross-references feature.

Cross-references created in InDesign (left) translate automatically to hyperlinks in the exported PDF document (right). Note that the entire Green 
Light District reference, including its page number, is within a <Link> tag in the Acrobat Tags pane. The improved export functionality of InDesign 
also correctly includes the Link – OBJR element required for proper link functionality in an accessible PDF document.

Add interactive form elements
With the addition of form-creation features in InDesign CS6, there is now additional support for tagging of 
certain interactive elements, such as form fields and buttons. An exported InDesign form contains the 
necessary <Annot> (annotation) tags to make it accessible in the resulting PDF document.

InDesign CS6 supports creation of checkboxes, combo and list boxes, radio buttons, text fields, and signature 
fields, all of which are created in the Buttons and Forms panel (Window > Interactive > Buttons and Forms). 
Each form element has both a name value and a description value that must be part of its definition. The 
description is essential for accessibility, because it acts as both the tooltip and as the alt text for the form item. 
The form can also have a visible label (for example, Name, Company, Phone) on the page, but as a user tabs 
from field to field or box to box, only the information assigned to the form element is read out; the adjacent 
text is not.
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When setting up form elements in InDesign, properly identifying the button is essential for accessibility. In this radio button example, each of the 
three choices shares the same name and description in the Buttons and Forms panel. The shared name identifies the three options as part of the 
same either/or choice (only one can be selected). The description acts as both the tooltip and an identifier read out by screen reading software. The 
Button Value field identifies the specific choice and is also read by the screen reader. In this example, as the user makes a radio button choice using 
the keyboard, “Reasons. Business. Radio Button. Checked” would be read aloud.

It’s essential to make sure that the tab order of the various form elements (including Submit buttons) is 
established correctly prior to export so that as the user tabs through—or is guided with an assistive device —
the form fields and options, the user is advanced to each step in the proper order. When your form is designed 
and its functionality is defined in the Buttons and Forms panel, review the Tab Order dialog (Object > 
Interactive > Set Tab Order) to confirm that all form elements are listed in the proper order. Make any 
necessary adjustments or corrections using the Move Up and Move Down buttons. Alternately, you can add 
your form elements to the Articles panel in the appropriate tab order, but double-checking the order in the Tab 
Order dialog is still a good quality control measure. 

The Tab Order dialog lists the order that a user moves through a form with either the Tab key or an assistive device from top to bottom. 

Add file metadata to the InDesign document
Accessible PDF documents require, at a minimum, a document title and a brief description of the contents. This 
information is stored in the file’s metadata, which you can access from the Document Properties dialog in 
Acrobat. The metadata can (and should) originate in the InDesign document’s File Information dialog (File > 
File Info), where it can be modified and updated easily and preserved each time a new PDF document is 
created.

Tip
Form field order is 
most consistently 
maintained when 
form fields and other 
elements (checkboxes, 
radio buttons, and so 
on) are anchored in a 
text frame containing 
the entire form. 
Because text in a frame 
is a linear flow, that 
flow automatically 
establishes the tab 
order of the form 
elements.
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File metadata entered in the Description tab of the InDesign File Information dialog.

File metadata from InDesign reflected in the Description tab of the Acrobat Document Properties dialog.

Export for accessibility
After you prepared the document for accessibility in InDesign, you are ready to export it (File > Export) to PDF 
using the Adobe PDF (Interactive) or Adobe PDF (Print) format options. Which PDF type you choose depends 
upon whether or not your document contains interactive elements such as forms, buttons, audio, or video. 
Although the formatting is the same for both PDF types, they offer different options in their respective dialog 
boxes.. The Adobe PDF (Print) format exports bookmarks and hyperlinks but not buttons, audio, video, or 
animation. You can only opt to include the appearance of these interactive elements — not their 
functionality — or to not include them at all.

To be accessible, the exported PDF must be tagged, so make sure you select the Create Tagged PDF option in 
the Export dialog box for either PDF type. In the Export to Interactive PDF dialog, select the Use Structure for 
Tab Order option to save yourself that step in Acrobat later on. To activate bookmarking, hyperlinks, cross-
references, and buttons, set the Forms and Media option to Include All. All other settings in the dialog are 
optional and subject to your specific needs or preferences. To automatically open the PDF document as soon 
as the export is completed, select the View After Exporting option. You can then move on to the final few steps 
required in Acrobat X Pro.

Tip
In the export process, 
a semicolon and space 
are added before the 
first keyword in the 
Keywords field of the 
Acrobat Document 
Properties dialog. 
This semicolon can 
cause problems 
with the successful 
interpretation of the 
keywords. You should 
delete the semicolon 
each time you create a 
new PDF document.
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Whether you require an interactive PDF with the appropriate features or a print PDF, you must select the Create Tagged PDF option to add the 
necessary tagging for screen readers. To enable all bookmark, hyperlink, and cross-reference functionality in a print PDF, select the Bookmarks and 
Hyperlinks options. When exporting an interactive PDF, choose Include All Forms and Media to enable both navigational features and interactive 
elements. To save a later step in Acrobat, choose the Use Structure for Tab Order option. The order in the Articles panel is always used first. If there’s 
no Articles panel ordering, the document’s XML structure (if any) is followed.

Review the exported PDF in Acrobat X Pro
As with any published document, it’s always a sound policy to review the final version for any potential 
unexpected results. Looking at the tagging structure in the Acrobat Tags pane may help foster a better 
understanding of the connection between your InDesign preparation and the final PDF document. 

The Acrobat Order pane might not match the order you establish in InDesign’s Articles panel, and it doesn’t 
necessarily reflect the reading order used by assistive technologies and the Acrobat Read Out Loud feature. 
Only the Tags panel ordering, as determined by the arrangement of content in the InDesign Articles panel, 
represents the reading order of the PDF content, regardless of the sequence shown in the Order panel or in the 
Acrobat Reflow mode.

Assign a document language in Acrobat X Pro
After you’ve created the PDF file, you can move to Acrobat X Pro to complete the remaining steps to make the 
PDF document accessible. The first step is to set the document’s language in the Advanced tab of the File 
Properties dialog (File > Properties). InDesign has no corresponding setting, so you must set the language in 
Acrobat. It’s also recommended that you set the document to display its title in the document window’s title 
bar rather than its filename. You can make that change in the  Initial View options of the Document Properties 
dialog.
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Language choices in the Reading Options area of the Advanced Document Properties options in Acrobat X Pro.

Because the document title (bottom) stored in the PDF file’s metadata is often more logical, accurate, and screen reader-friendly than a PDF filename 
(top), it should be set to display in the title bar.

Specify the tab order
The structure created in the InDesign Articles panel is exported to the PDF file, but it is not automatically set as 
the order followed when tabbing through interactive elements like hyperlinks and form fields. You must 
establish the tab order the Acrobat Page Thumbnails pane (View > Show/Hide > Navigation Panes > Page 
Thumbnails). Highlight all of the documents page thumbnails, and then choose Page Properties from the 
Options menu in the Page Thumbnails pane. In the Tab Order area of the Page Properties dialog, change the 
content order from Unspecified to Use Document Structure.

If you’ve exported your document as an Interactive PDF file and selected the Use Structure for Tab Order 
option, you can skip this step. Because print version of the InDesign Export Adobe PDF dialog does not have 
this option, you must select it in Acrobat.

Tip
To quickly select all 
page thumbnails in 
the Acrobat Page 
Thumbnails pane, 
click the first page 
thumbnail, then press 
Command+A (Mac 
OS) or Control+A 
(Windows®).
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The tab order of a PDF file exported from InDesign is set to Unspecified by default, which is not a reflection of the structure established in the 
InDesign Article’s panel. To establish the InDesign structure in the PDFdocument, you must select Use Document Structure.

Run the Acrobat X Pro accessibility check
From the Acrobat Tools pane, expand the Accessibility options (View > Tools > Accessibility), and select Full 
Check. Make sure that the Create Accessibility Report option is selected. This option shows whether the 
document is error free, and if not, details the problems.

The default settings of the Acrobat Accessibility Full Check dialog, including the option to create a report after completion.
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The Accessibility report should indicate that no errors were found. If the check revealed an error, such as missing alt text for an image, it’s best to fix 
that error in InDesign, reexport, and repeat the Acrobat steps rather than fixing the problem only in the PDF. Keeping the source InDesign file fully 
optimized for accessible output affords the smoothest process for any future updates and exports.

Ad	ditional resources
•	 U.S. Government’s Official Section 508 website 

www.section508.gov

•	 Video on creating PDF forms with InDesign CS6 
tv.adobe.com/watch/visual-design-cs6/creating-pdf-forms-with-indesign-cs6

•	 Adobe Systems Accessibility Resource Center 
www.adobe.com/accessibility

•	 InDesign Accessibility Product Page 
www.adobe.com/accessibility/products/indesign

•	 Video on preparing accessible PDF documents with Adobe InDesign CS5.5: Part I 
http://tv.adobe.com/watch/accessibility-adobe/part-1-new-accessibility-features-in-indesign-cs55

•	 Video on preparing accessible PDF documents with Adobe InDesign CS5.5: Part II 
http://tv.adobe.com/watch/accessibility-adobe/part-2-exporting-and-finalizing-your-pdf

•	 InDesign voluntary product accessibility template 
www.adobe.com/accessibility/products/compliance/#indesigncs55
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http://tv.adobe.com/watch/accessibility-adobe/part
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